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1. GETTING STARTED

This User Manual will help you to familiarize yourself with the 18-Hole Stroke Play application. The
dialog boxes and controls in this User Manual may appear different from the dialog boxes and controls
that appear on your computer screen.

Stroke play, also known as medal play, is a form of competition based on the cumulative number of
strokes taken, either over one round or several. This application is for 18-hole rounds.

The 18-Hole Stroke Play application is used to set up and run 18-hole stroke play events, including and
not limited to:

* Individual (up to 15 flights) low gross and low net.

e Callaway handicapping.

* Individual Stableford (up to 15 flights) (gross, net and quota).

» Team Stableford (up to 15 flights) (gross, net and quota).

» Select players qualifying.

» Export player scores into Handicap Creator 2011.

* Inter-Club events.

» Select skins game for all of above.

e Select players playing skins.
This User Manual describes all the steps necessary to complete a 18-hole stroke play event.
Please take a moment to familiarize yourself with the text conventions, terms, and controls used in this
User Manual.

1.1 Text Conventions

The examples below explain the specially formatted text used in this User Manual.

» Dialog boxes and control names appear in bold type: Select Member dialog

» Keyboard key names appear in bold type: Home, End, Backspace , Tab

» Keyboard keys that must be pressed at the same time to perform a task appear in bold type with
a plus (+) between the key names: Alt+H

» Drives appear as capital letters: drive C

» File names appear in italics with an initial capital letter: Setup.exe

» Command line statements appear in lower case bold type: a:\install

« Names of icons appear in bold type: My Computer icon

* Menu items, option buttons, and check boxes appear in bold type: Programs , Accessories
Tournament option, Use 18-Hole Factor check box

1.2 Terms

You can use either a single-button mouse or a multiple-button mouse with this application.

If you have a multiple-button mouse, the left mouse button is the primary mouse button, unless you have
configured it differently. Any procedure that requires you to click the secondary button will refer to it as
“the right mouse button.”

If you have a single-button mouse, pressing the Ctrl key while clicking the mouse button is the same as
clicking the right mouse button.

This User Manual uses the following terms.

Term Meaning
18-Hole Stroke Play Name of application.
Press Strike a key from the keyboard.

Type Strike a key from the keyboard to display text
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on the screen. Do not press the Enter key
after entry is complete, unless instructed to do

Sso.
Enter Type the entry, then press the Enter key.
Point Position the mouse pointer until the tip of the

pointer rest on whatever you want to point to
on the screen.

Click Point, press and immediately release the left
mouse button without moving the mouse.

Double-click Point, press and immediately release the
mouse button twice without moving the mouse.

Drag Point and then hold down the mouse button as
you move the mouse.

Choose Click a command button. Click an item from a
menu bar or dropdown menu.

Select Click a command button. Click an item from a

menu bar or dropdown menu. Click an option
button to make a black dot appear. Click a
check box to make an X appear. Click and
item in a list box, then click OK, or double click
and item in a list.

Clear Click an option button to make the black dot
disappear. Click a check box to make the X
disappear.

In Windows, the terms choose and select have different and specific meanings. Selecting an item usually
means mark it with the selection cursor, which can appear as a highlight, a dotted rectangle, or both. You
also select check boxes and option buttons in dialogs. Selecting alone does not initiate an action.

You choose an item to carry out an action. For example, choosing a command button or menu item
might open a dialog or carry out a command. You often need to select an item before you can choose it.

1.3 Controls

You can use a combination of mouse and keyboard techniques. For example, you could click an item to
select it, and then press Enter from the keyboard to choose it. When a procedure in this User Manual
says to choose an item, generally you can use whichever method you prefer.

This section gives basic information about controls and their functions. Throughout this Guide, the control
name will be in bold type. For example, select OK or select Courses Table check box. The controls
found in the 9-Hole Stroke Play application are similar as shown below.
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Button (114 Tulerm Par |E5it Add Edit Delete Setup

Text Box | | Frame { Lomgeziz
Cotrho Box | Hole-By-Hole j| |
L ]
Icon lw
Option Button ® Eirst Name [John Smith)

Checl Box ¥ Couwrses Table List Box Oranges

Bananas
Spin Control |15 [4] | Pears
1.3.1 Button or Command Button

You choose a command button to initiate an action, such as carrying out or cancelling a command.
Common command buttons are OK and Cancel. They are often located along the bottom or on the right
side of the dialog.

A command button, followed by an ellipsis (...) or a double greater-than sign (>>) opens another dialog
box.

Unavailable command buttons are dimmed. The currently selected button has a darker border than other
buttons. You can choose the currently selected button, simply by pressing the Enter key.

To choose a command button, click the command button. Or press the Tab key until the button you want
is selected, and then press the Enter key.

1.3.2 Text Box

You type information into a text box. When you move to an empty text box, an insertion point (a flashing
vertical bar) appears. The text you type starts at the insertion point.

If the box you move to already contains text, and the text is highlighted, any text you type replaces it. You
can also delete the existing text by pressing the Delete key or Backspace key.

To select text in a text box, drag the pointer across the text, or double-click a word to select one word at a
time. Or press and hold down the Shift key while pressing an Arrow key.

1.3.3 Combo Box

A combo box appears initially as a rectangular box containing the current selection. When you select the
down arrow in the square box at the right, a list of available choices appears. If there are more items than
can fit in the box, scroll bars are provided.

To open a combo box and select an item:
1. Click the arrow at the right to see a list of available choices.

2. Click the up or down scroll arrow, if visible or drag the scroll box to move to the item you want to
select.

3. Click the item.

1.34 Option Button

Option buttons represent a group of mutually exclusive options. You can select only one option at a time.
If you already have one option selected, your current selection replaces it. The option buttons are,
generally enclosed in a frame. The selected option button contains a black dot. Names of unavailable
options are dimmed.
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To select an option button, click the option button.

1.35 Check Box

A check box means you can select or clear an option. You can select as many check-box options as
needed. When a check box is selected, it contains an X. Names of unavailable options are dimmed.

To select or clear check boxes, click the check box.

1.3.6 Spin Control

The spin control is a control that works with another control, such as a text box to increment and
decrement values. It can also, scroll back and forth through a range of values or a list of items.

To continue to increment the value, click the up (or right) arrow of the spin control and hold down the
mouse button, then release the mouse button when the desired value is displayed. Likewise, repeat the
latter by clicking the down (or left) arrow to decrement the value. If a flashing vertical bar appears when
you drag the mouse cursor over the area left of the up (or right) and down (or left) arrows, the control
contains a text box. If the area is highlighted or selected you can change the value or list with the up and
down (or left and right) arrow keys from the keyboard.

1.3.7 Menu Bar

The menu bar contains a list of menu items. Some commands carry out an action immediately; others
display a dialog so that you can select options, or a dropdown menu. Dimmed menu items are
unavailable.

A menu item followed by an ellipsis (...) opens another dialog.

1.3.8 Frame

A frame groups the controls together. The name of the frame usually describes the group of controls.

1.3.9 Icon

Icons are small pictures that represent something. For example, the icon in the previous illustration
represents a male. Some icons act as a command button.

1.3.10 List Box

A list box displays a list of choices. If there are more choices than can fit in the box, scroll bars are
provided so you can move quickly through the list. Some list boxes are accompanied with a text box. If
you type a letter in the text box the list box scrolls to match the letter you type.

Usually, you can select only one item in a list box. There are some cases when you can select more than
one item.

To select a single item from a list box:

» Use the method as described above or

»  Click the scroll arrows until the item you want to select appears in the list

e Click the item, and then choose the appropriate command button or double-click the item to
select it and complete the command all in one step.

To select multiple sequential items in a list, click the first item you want to select, and then drag the cursor
to the last item you want to select.

To cancel the selection, click any item in the list or click the first item you want to select, press and hold
down the Shift key, and click the last item you want to select. Both items, and all items in between, are
selected.
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To select multiple non-sequential items in a list, press and hold down the Ctrl key, and click each item
you want to select.

To cancel a selection, press and hold down the Ctrl key, and click the item again.

1.4 System Requirements

The application will operate on the following operating systems and configurations:

* PC with a 266 MHz or greater Pentium-class processor

e Microsoft Windows 95/98/2000/ME/XP/Vista

* 256 MB of RAM or greater

e 15 MB available hard drive space

e CDdrive

e Monitor supporting 800 x 600 or greater resolution with at least 256 colors

Set DPI Setting to 96 DPI
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2. INSTALLATION AND SETUP

The application and Handicap Creator 2011 must be installed to the C: drive, before the application can
run properly. Please look at the appropriate instructions below.

2.1 Installing from Website

To install application from Golfsoft Software website:

Logon to the Golfsoft Software website (www.golfsoftsoftware.ca).

Click the 18-Hole Stroke Play hyperlink.

Click the Download Application hyperlink and save to your desktop.
When the download is complete and successful, logoff from the website.
Double-click the Stroke18Setup icon from your desktop.

Delete the Stroke18Setup icon from your desktop.

ouhrwNE

2.2 Installing from CD-ROM

To install application from CD-ROM:

1. Turn on your computer and start Microsoft Windows 95/98/2000/ME/XP/Vista.

2. Place the application CD in your CD-ROM drive.

3. If AutoPlay is enabled, the installation will begin once the drive closes, follow the on-screen
instructions.
Or
If Auto Play is not enabled, you will need to manually install the application. Double-click the My
Computer icon on your desktop, double-click the icon for your CD-ROM drive, and then double-
click the Stroke18Setup.exe icon. Once the installation begins follow the on-screen instructions.

2.3 Uninstalling Application

To uninstall application:

1. Turn on your computer and start Microsoft Windows 95/98/NT4/2000/ME/XP/Vista.

2. Click the Start button on the taskbar, point to Settings , and then click Control Panel .

3. Double-click Add or Remove Programs , select Golfsoft Software 18-Hole Stroke Play , and
then click Add/Remove to uninstall the application.
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24 Using Application

24.1 Starting Application
To start 18-Hole Stoke Play application from the Start Menu , click the Start button on the task bar, point
to Programs , then Golfsoft Software , and then select 18-Hole Stroke Play to launch the application.

To start 18-Hole Stoke Play application from the Handicap Manager 2011 , click the 18-Hole Stoke Play
button.

To start 18-Hole Stoke Play application from the desktop , double-click the 18-Hole Stoke Play
application icon on your desktop.

2.4.2 Start Up

Once the application is started, a Start Up window will appear.

startup x|

System Manager Access

Sign Up

Print Scorecards

|
|
| Hemove
|
| Add Scores

Men's Field Day #4

18-Hole Stroke Play | E5€ Ke¥
- to Cancel
Click any button.
2.4.3 Command Buttons
243.1 System Manager Access

Click the System Manager Access button to obtain access to the main 18-Hole Stroke Play application.
If the application is password protected, type in the System Manager password and click the OK button.

2.4.3.2 Sign Up

This command button allows members to sign up their name and other players to the 18-hole stroke play
competition, which has been previously setup by the System Manager. The response to this button will
require the member to enter his/her access code.

To sign up for the competition, click the Sign Up button and enter a valid access code. These actions will
open the Tee Times dialog.

When the Tee Times dialog opens, the Current Mode will be Sign Up mode (Follow the instructions in
Section 4.6.4). Click Exit from the menu bar, to close the dialog.
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2.4.3.3 Remove

This command button allows members to remove their name and players that they signed up. The
response to this button will require the member to enter his/her access code.

To remove names from the competition, click the Remove button and enter a valid access code. These
actions will open the Tee Times dialog.

When the Tee Times dialog opens, the Current Mode will be Delete mode (Follow the instructions in
Section 4.6.5). Click Exit from the menu bar, to close the dialog.

2434 Print Scorecards

This command button allows members to print their scorecard and for players that they signed up. The
response to this button will require the member to enter his/her access code.

To print scorecard(s), click the Print Scorecards button and enter a valid access code. These actions
will open the Print Scorecards dialog.

Print Scorecards... ]

Scorecard for._.

Aleszsio, John
Lornie, Tom

MacRae, Mark All 33
Mattie, Francis =

-

e
et

£

&

]

3]

&

Franciz b attie - 'ou can print zcorecard for any of the players abowve.

1. Select players from the list on the left:

» Double-click players name,
» Click players name and click the >> button or
» Click the All >> button to select all players.

2. Click the Print button.
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2.4.3.5 Add Scores

This command button allows members to add their score and for players that they signed up. The
response to this button will require the member to enter his/her access code.

To add score(s), click the Add Scores button and enter a valid access code. These actions will open the
Add Scores... dialog.

x

Scores for__.
Add

Alezsio, John
Lormnie, Tom

> I J

MacRae, Mark :Cancel .
Mattie, Franciz =
| 4

Franciz Mattie - Yo can add zcores for any of the plavers above.

1. Select players from the list on the left:

* Double-click players name,
e Click players name and click the >> button or
e Click the All >> button to select all players.

2. Click the Add button.

3. Enter each player’s hole-by-hole score and click the Enter button (See Section 3.6.1.2 for
instructions).

2.4.3.6 Cancel

Click the Cancel button or press the Esc key from the keyboard to exit the Start Up window.
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3. MAIN MENU

The menu bar contains a list of menu items. Some commands carry out an action immediately; others
display a dialog so that you can select options, or a dropdown menu. Dimmed menu items are
unavailable.

A menu item followed by an ellipsis (...) opens another dialog.

To access any of the menu items, click the item or press the Alt key from the keyboard and at the same
time press the underscored letter of the menu item. Some of the menu items have dropdown menu
items.

3.1 File

The File menu item offers commands to 6 dropdown menus:

| File
[ew. ..
Open...
lase
Delete...

Prink Setup. ..

Exit

3.1.1 New...

To create a new event, click File|New... from the menu bar. This opens a New Event dialog, which
displays the default options for the 18-hole stroke play event. Set and select the options and click the
Add button.

Newbvent =

Mame af Event; [% Tournament I 40
MHame of Club: |Deep River Golf Club %

¥ Skinz
Drate: | Thursday, November 27, 2008 59| - Skins Format

Handicap:l Grozs & Met j| [ Stableford Handicap:l et j|

Allowance: [ 100% - . -
T}'DE af Stoke P'a_'r'_ Allovwance: | 1005 J
Round Tepe: | 18-Hales j ® |ndividual [® Use 18-Hole Factor

C) Team
O InterClub Eniry Fee: | $0.00
Entry Fee for Event

bember; $0.00 M on-tdember:| $0.00

F'a_l,l:| Pro Shop

Totsl Collected:|  $0.00 | Add Cancel

Ready ...

Name of Event — This text box allows users to enter the name of the event or competition.
Tournament — This check box selects the event as a tournament.
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Stableford — This check box selects the competition format as Stableford stroke play. This option will
determine the availability of some menus and options. If the Handicap option is selected to Gross, Net or

Callaway format, this check box will be disabled. Gross & Net or Net & Gross format must be selected to
enable this check box.

Stableford scoring systems are stroke-play formats in which the high total wins, not the low. That is

because in Stableford, your final score is not your stroke total, but rather the total points you have earned
for your scores on each individual hole.

Date — This is the date of the competition. Click the Calendar button, to select the date from the popup
calendar. The popup calendar displays instructions.

ﬂ March 2008 ﬂ

Su Mo Tuwe Th Fr 5a

1
2 2 4 5 6 7 8
9 10 11 [12]13 14 15
16 17 18 19 20 21 22
23 24 25 26 27 28 29
30 AN

March 12, 2008
Fresz Enter K.ey to Accept or
double click selection box.

Prezs Ezc Key ta Cancel

Handicap — This combo box allows users to select one of five options: Gross, Net, Gross & Net, Net &
Gross or Callaway format.

Allowance - This combo box allows users to select one of four options: 100%, 95%, 90% or 80%. This
control is not available, if the Handicap option is set to: Gross.

Skins — This check box enables skins and allows users to set skins options.

e Handicap — This combo box allows users to select one of two options: Gross or Net.

e Allowance - This combo box allows users to select one of four options: 100%, 95%, 90% or
80%. This control is not available, if the Handicap option is set to: Gross.

» Entry Fee — This text box allows users to enter the entry fee for the skins competition.
Type of Stroke Play — These options allows users to select the type of stroke play.
Entry Fee

 Member — This text box allows users to enter the entry fee for members.
 Non-Member — This text box allows users to enter the entry fee for non-members.

e Pay — This text box allows users to enter the collector of the entry fee for the competition or
where to pay the entry fee.

» Total Collected - This box displays the total amount of money collected for the competition.
Click Add button when finished.
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3.1.2 Open

To open an event that has been previously created, click File|[Open... from the menu bar. Select the
event from the list and click the Open button.

c:\golfsoftstrokeld

X
_ ClgiGdime |
| X
[Hole Number [ 1 [2 [3]4 5 (6 [ 788 /[ou[ 1 12]13714 15[16[17[18] In | Tot
| verdage (366 [160 (515|164 371 337 [417 173 561 3064 (358 |93 620376 523 151 (446 214 341 | 3022 6106
| Par [[4]3]5]3 4 af4]35]35f4 35453 f4]3][4]35]70]
[ Handicap [ 8 [17 [ 7 [13 71 [11]3 [15 5 [WEM(12 18 4 [10(6 [16( 28 [14 N0 |

3.1.3 Close

To close an opened event and return to the main screen, click File|Close from the menu bar.

3.14 Delete

To delete an event from the database, click File|Delete... from the menu bar. Select the event from the
list and click the Delete button.

3.1.5 Print Setup

To set the properties of the default printer, click File|Print Setup from the menu bar.

3.1.6 Exit

To exit the application, click File|Exit from the menu bar.
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3.2 Courses...

To execute the Courses Management application (COURSES.EXE), click Courses... from the menu bar.
See the Courses Management User Manual for instructions.

3.3 Members...

To execute the Members Management application (MEMBERS.EXE), click Members... from the menu
bar.

See the Members Management User Manual for instructions.

3.4 Non-Members...

To execute the Non-Members Management application (NONMEMS.EXE), click Non-Members... from
the menu bar.

See the Non-Members Management User Manual for instructions.
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3.5 Sign Up...

This menu item is not available, if the Type of Stroke Play option has been set to Inter-Club. The Inter-
Club Scorecard dialog is used to sign up players.

To access the Sign Up Players dialog, click Sign Up... from the menu bar.

Sign Up Players ﬂ

Type Hame or Select from hst:

I | | Az IAIready signed up

Mantler, Steve - e Mattie. Franciz (13.1]
Markus, Jamie

Marquardt, Darwin
Marrs, John
Martin, Dan
Martin, Jazon
Martin, Jazon
Martin, Tony
Maszon. Bill

Mazon, Temny
May. Ken [ I 1
Mchllister. Ray [% Ask for 18-Hole Handicap Factor

:EE:HE{JE:::ZH [® Mo Factor Calc. Maximum Handicap

McCallum, Bentl A
HEE:ur;:, H?:'.'jn?; | Update Handicap Factors I

McCilguham, Brad |
McClelland, Greg | | BGG

(1] | Cancel

Ready...

Note: To sign up players directly to tee times, sign up players through the Tee Times command button
option, as described in Section 4.6.4.

To sign up players, select names from the list on the left.
To remove a player, click the name from the list on the right.

Ask for 18-Hole Handicap Factor — This check box selects the option of prompting the user to enter a
manual Handicap Factor.

No Factor Calc. Maximum Handicap — This check box selects the method for calculating the player’s
Handicap, if the player has no Handicap Factor. If checked, the player’'s Handicap will be calculated from
the maximum Handicap Factor allowed for the gender of the player. If not checked, the Handicap will be
zero or scratch.

Update Handicap Factors — This command button updates Handicap Factors and recalculates
Handicaps for each player in the member’s database.

New — This command button allows users to add a new player to the non-members database. If the
Members Only option has been selected, this button will be disabled.
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3.6

Scores

Page 3-6

To access the Scores dialog, click Scores... from the menu bar. The Scores dialog display will vary,
depending on what options have been chosen. The text of the dropdown menu items will also vary and
some menu items will be disabled.

There are two types of scores displays: Individual scores (See Section 3.6.1) and Inter-Club scores (See
Section 3.6.2).

3.6.1 Individual Scores
5
Exit add Edit Delete View Skins Qualify  Print  Export...
Hole Mumber (1 2 3[4 85167 83 [ouw|3a[7iqz|{1a 4151617 78] n [Ta
Yardage 566160515 54371 337|417 173561 2054|358 53| 520|576 523 51 [446]214)341 [Bozz [B108|.

Par O e o e = e e e 5
Handicap O e = 5|:|]12 18] 4 [qole el 2] s[4 o[ 18 | Net
FeileyOBrien |4 [4 [E ] 4[4 6 (a3 4 |3a|az(sa]5]a]6]4]5]|4an|78]| 12|66 [=]
Brock Sine AR EEEE R E R SRR EE
hark Attley slalalalalslelalls3al4laslslzlzls 4241|8071
Steve DDonrel [[5 [ [8  ¢[saalalclaalalzclslela]ls[a]s|43[82|713 |6
andiewRowat |4 [3 6 [Bl s aaz]c|3z|elsa6la]alalsa]an|sz]11]n
Erent Clifford slalls4|s]s|slzsaas[s5elzlz]s]4]+]a3[es|313]70
John Kiser AEE R E SR E R EE R E R E N A R R
Bill Scheel slalela|s5lalsl4alclanlslz|c|slala|s 444384 15]86a
LamySkinner |5 [2 5[4 (s [s5]s5a5 |44z 5|z lala|s 4544 |84 [12]72
Paul Sequin slalsllala|s]slallcla2lallalz]lslclalEels4]a]a3]es|[14]7
DonMoarizan |4 [E5 4 [as|s5a7laslaa|c|sslalela]s|az]ss[12]73
Danyl Craig 4 [aellzlslslslalclmlelz]cfalzlafr4]s]4a]es|q11]7s
Dan Pope slalelalslslelallaaalallzalalzlsfals]s]4[8n|11]7s
Bwankeaey |5 |36 [5[6 6|6z aa|sz([s|e|c|as[a]4]5]42]ee 1568
GemyPulcine |7 2 B3 [sals2 74254 5|5 [clfal5]4]|5[44 86 76|70
Dian Patrick gl45]lsls]sdalizlslaallelz]c|s|al4a]alla]s]42]8s|14]72
Gamy'weston | 5 |3 |8 (428l a5 (aslfaz 7 [2cale]4 [=2]41 8614|772
TorwBelcowt |5 4 [6 @l s[s5]s s (a(43faac|sls5a]s 744386 |12]74
MikeBouden: (B[4 [5 ]« [a 743 c|a3]slaz|asllz]cll5 6|43 ]se |17 ]7
Lorne Feon gllallzlialzlslslzlvslaslalalclalzlz]s|a]s|42[ez|q76]7

CorvadStesman |5 [4 (B3 sl6 s e {aaas 7 |slalalZ|[aa]as]sr|15]72
Francis Mattie £ 4 ERIFELEN 505 [F3| 5] 42 [ 4 L5 5 EFIE | 4 (4| 45 | 87 |14l 73
GeorgeBerube (| 4 (36 [4 /6 (4|5 (55 [4a1 |5 [5c 5544 6|46 |8z 3]74 |~
Qualify: Sking  Qualfy and Skine - Normal Fllighl Farmnat ‘Sort By D ate Players Golfers
[Fready... | No Flights | Gross Seores | GrossTotal | 2008/09/06 | 81 | @1

This dialog allows users to:

Add, edit and view player scores.
Select first place play-off winners.
Toggle between viewing skins only and hole-by-hole total scores.
View Handicaps or Handicap Factors.
Print skins results.
Print net, gross, net & gross, gross & net and Callaway scores.
Print Stableford points to the default printer.
Print scorecards.
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3.6.1.1 Exit

To exit the Scores window, click Exit from the menu bar.

3.6.1.2 Add
The Add menu item offers commands to 2 dropdown menus.
Add

Players. ..
Round...

To add players:
1. Click Add|Players... from the menu bar.
2. Select players from the list on the left and click the Add button.
To add player’s round:
1. Click Add|Round... from the menu bar
or
press F5 key from keyboard.
2. Select player from the list and click the Add Round button.
Note: Players will not appear in the list, if their round has been added.

Francis Mattie - Current Course Handicap = 14, Factor = 13.1 ﬂ
| Amnprior Golf Club | 684120 || Saturday, September 6, 2008 |

HoleMumber | 1 | 2 [ 3 [ 4 [ 5[ 6 | 78 |3 [ Ou|10/11[12]13 14 [15[16 [17 18] In | Tct
vardage | 366|160 (515|134 |371 (337 [ 417 173|561 | 3084 (358 | 93 | 520 | 376|523 [151 | 446 |214 341 | 3022 | 5106
Par 4285|2444z |s5]35[4/23|5]a|5 (343 ]a]323]70

Handicap || 9 |17 7 |13 1 |11 ][5 |15 5 (B 12 |18 4 [10] 6 [16] 2 | & |14 |NE
| Scoe |4 /47|36 [5|5 35 [42[4 /45|57 /5[7 4]4]45]87 |
L _Net (304628 44 3]4]35[3/4/4]4]6]5[6 3 ]3]38]7 |
| MetPainks |3 |1 /1 [3/1 02022 3[18 3 /1 /3]2/1/0f0/2]3]|715]|3 |
| Adusted | 4 |4 |7 |3 |6 |55 /3 /5|42 |4 /4|55 |7/5[64]4]44]86|

Score must be > 0and <=15 [~ Did Not Show .
[ Tournament Score [ Did Mot Finizh w
[~ Disqualified Ezc Key
[ Did Mot Beturn Scorecard to Cancel

YW as the raund a tournament? Press the T-Key to change. Fress the EMTER key to post score.

3. Type the hole-by-hole scores and click the Enter button.
The flashing arrow (not shown) indicates the current hole.

If no scores are available, you can select any of the 4 check boxes: Did Not Show, Did Not Finish,
Disqualified and Did Not return Scorecard.
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3.6.1.3 Edit

The Edit menu item offers commands to 4 dropdown menus.

Edit

Round. ..
Handicap. ..
Handicap Factor...
Playoff \Winner. ..

To edit player’s round:

1. Click Edit|Round... from the menu bar
or
press F6 key from the keyboard.
2. Select player from list and click the Edit Round button.
Players will not appear in the list, if their round has not been added.
3. Edit hole-by-hole scores of the selected player and click the OK button.
To move the flashing arrow, click the Hole Number display area, above the hole-score that
requires adjustment.

To edit player's Handicap:
1. Click Edit{Handicap... from the menu bar.

2. Select player from list and click the Edit Hcp button.
3. Enter new Handicap and click the OK button.

To edit player's Handicap Factor:

1. Click Edit{Handicap Factor... from the menu bar.
2. Select player from list and click the Edit HF button.
3. Enter new Handicap Factor and click the OK button.

To edit or select the playoff winner:

1. Click Edit|Playoff Winner... from the menu bar.
2. Select playoff winner from the list and click the Winner button or click Reset button to reset
playoff winner selection.

3.6.1.4 Delete

The Delete menu item offers commands to 2 dropdown menus.

Delete

Flayers. ..
Players with Mo Scaores. .

To delete players:

1. Click Delete|Players... from the menu bar.
2. Select players from the list and click the Delete button.

To delete players without scores:
1. Click Delete|Players with No Scores... from the menu bar.
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3.6.15 View

The View menu item offers commands to 12 dropdown menus. Depending on what options that were
previously selected, some menu items may vary. The text of the dropdown menu items will also vary and
some menu items may be disabled.

| view
Flight b
ar0ss SCores
[et Scores
Callaway Scores
Equitable Stroke Contral
v Stableford Poinks
Skins Onky 3
v Handicap Fackors
Handicaps
v Show Scores
Hide Scores
Qualifying Players. ..
Range...
All

If the 18-hole stroke play competition is broken into flights, click View|Flight »|x Flight (y_to x) from the
menu bar. Where, x is the flight letter (A to O), y and x is the Handicap range.

To view gross scores, click View|Gross Scores from the menu bar.

To view net scores, click View|Net Scores from the menu bar.

To view Callaway scores, click View|Callaway Scores from the menu bar.

To view Equitable Stroke Control scores, click View|Equitable Stroke Control  from the menu bar.

To view skins only, click View|Skins Only »|x Flight (y to x) from the menu bar. Where, x is the flight
letter (A to O), y and x is the handicap range.

To view Handicap Factors, click View|Handciap Factors from the menu bar.
To view Handicaps, click View|Handicaps from the menu bar.
To hide scores, click View|Hide Scores from menu bar and show scores, click View|Show Scores .
To view qualifying players only:
1. Click View|Qualifying Players... from the menu bar.
2. Select Handicap range and click the OK button.

To view a range of handicaps:

1. Click View|Range... from the menu bar.
2. Select Handicap range and click the OK button.

To view all players, click View|All from the menu bar.
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3.6.1.6 Skins

The Skins menu item offers commands to 3 dropdown menus. If the Skins option has not been
selected, this menu item will be disabled.

Skins

Setup,..
add. ..

Rermove...

To setup skins:
1. Click Skins|Setup... from the menu bar.

skins setep NN B[l skins setw X

Exit Exit

|D: l_ Flayers: I_ Flights: IT |D: l? Flayers: IT Flights: IT

Select Skinz Flight Select Skinz Flight
Fight Fight Updats
Ml I @ ta I @ |j| I 4 @ ta I 9 @ Cancel |

| Ready ... | Ready ...

2. Select Flight option and range.

3. Click Update button.

4. Repeat Steps 2 and 3 for more flights.

5. Click Exit from the menu bar when finished.

To add players playing skins:

1. Click Skins|Add from the menu bar.

2. Click players from the list on the left and click OK button.
To remove players playing skins:

1. Click Skins|Remove from the menu bar.
2. Click players from the list on the left and click OK button.
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3.6.1.7 Print

The Print menu item offers commands to 5 dropdown menus.

Depending on the options that were chosen, some menu items will vary from what is shown below. The
text of the dropdown menu items will also vary.

| Print
Gross Scores (44 bo 12)
Mek Stableford Paoinks (+4 ko 12)
Gross & Met Winners (+4 to 12)
Skins
Scorecards *

Depending on what options have been chosen, some menu items will be disabled.

First Dropdown Menu Item:

To print net scores, click Print|Net Scores from menu bar (See sample in Section 6.6).
Handicap : Net, Net & Gross.
Stableford : clear.

To print gross scores, click Print|Gross Scores from the menu bar (See sample in Section 6.7).
Handicap : Gross, Gross & Net.
Stableford : clear.

To print Callaway scores, click Print|Callaway Scores from the menu bar (See sample in Section 6.8).
Handicap : Callaway.
Stableford : clear.

Second Dropdown Menu Item:

To print net Stableford points, click Print|Net Stableford Points from menu bar (See sample in Section
6.11).

Handicap : Gross & Net, Net & Gross,

Stableford : Net.

To print gross Stableford points, click Print|Gross Stableford Points  from the menu bar (See sample in
Section 6.12).

Handicap : Gross & Net, Net & Gross.

Stableford : Gross.

To print quota Stableford points, click Print|Quota Stableford Points  from the menu bar (See sample in
Section 6.13).

Handicap : Gross & Net, Net & Gross,

Stableford : Quota.

Fourth Dropdown Menu Item:
To enable this menu item, the display format must be Skins Only. See View Skins Only Section 3.6.1.5.

To print skins results, click Print|Net Skins Results from the menu bar.
Skins : select.
Skins Handicap : Net

To print skins results, click Print|Gross Skins Results  from the menu bar (See sample in Section 6.1).
Skins : select.
Skins Handicap : Gross
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Fifth Dropdown Menu Item:

To print official scorecards, click Print|Scorecards > Official Scorecards... from the menu bar (See
sample in Section 6.14.1).
To print Stableford scorecards, click Print|Scorecards » Stableford... from the menu bar (See samples
in Sections 6.14.2, 6.14.3 and 6.14.4).

Stableford : select
Third Dropdown Menu Item:

To print low gross and low net winners, click Print|Gross and Net Winners... from the menu bar (See
sample in Section 6.9).

Handicap : Gross & Net.

Print winners x|

Current Settings =
Individual Stroke Play Flight: A Print I

Handiu:ap:| Gross and Net [ Winners Orly:
Allowance: | 1002 sitfioll Cancel

Apply

[arozs I et
’VLn:-w Gross: | 7 3: ’V Low Met: | 5 3: Flayers: | 30

[ 1zt Place Plapaff [ 13t Place Plapaff

Low Gross Low Met
1 | Reiley O'Brien [78) 1 | Mark Attley [69)
2 | Andrew Rowat (82) 2 | John Kiser [71)
3 | Larry Skinner (84) 3 | Don Monison (73]
4 | Daryl Craig [85) 4 | Dan Pope [74)
5 | Tony Belcourt [86) 5 | Mike Boudens [75)
6 | Helmut Plattner [87) 6 |
7 | Blake Sutherland (87) 7|

Feady ...

Low Gross - This control allows users increase and decrease the number of low gross positions. Click
the appropriate Up and Down scroll arrows.

Low Net — This control allows users increase and decrease the number of low net positions. Click the
appropriate Up and Down scroll arrows.

Winners Only — Select this check box, if you want to print winners only. Otherwise, the printout will
include each player’s hole-by-hole scores.

Print — This command button prints the results to the default printer.
Apply — This command button refreshes the low gross and low net winners.
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Third Dropdown Menu Item:

To print low net and low gross winners, click Print|Net and Gross Winners...

sample in Section 6.10).
Handicap : Net & Gross.

Print Met and Gross Winners

Page 3-13

from the menu bar (See

Curment Settings

Individual Stroke Play

Handicap: | Met and Gross

Allowance: | 1003

Flight: | A
+4 to 12

Lo Met: | ?3:

"Nﬂt—' "GTDSS

Low Gross: | F 3:

[ 13t Place Playoff

"Low Net

1 | Tom Roche [34)

2 | Todd Chaput [34)

3 | Malcolm James (35)

4 | Don Morrison [36]

L |Jerem}l Stewart [37]

6 | Peter Belleau [38)

7 | Rob McLaren [39)

Players: | 16

[ 13t Place Playoff

Cancel

Apply

" Low Grossz

1 | Ken Titterington (38)

2 | Eric Senohrabek (39)

3 | Tim Hartwig (41)

4 | Dave Ethier [41)

5 | Kevin Lee [43)

6 | David Miller [44)

¥ | Franciz Boucher [47]

Ready ..

Low Net — This control allows users increase and decrease the number of low net positions. Click the

appropriate Up and Down scroll arrows.

Low Gross - This control allows users increase and decrease the number of low gross positions. Click
the appropriate Up and Down scroll arrows.

Winners Only — Select this check box, if you want to print winners only. Otherwise, the printout will

include each player’s hole-by-hole scores.

Print — This command button prints the results to the default printer.
Apply — This command button refreshes the low net and low gross winners.

3.6.1.8 Export

To export all the scores to the Handicap System:

1. Click Export from the menu bar.
2. Click the Yes button on the first Confirm...

window.

3. Click the Yes button on the next Confirm... window, to flag qualifying scores.
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3.6.2 Inter-Club Scores
5

Exit mdd Edit Delste Wiew Skins  Print

Amprior [871) ] Mississippi (865) | Renfrew [886) [ Twin Rivers (920) |
‘Deep River [306]; Pembroke [B65] Island Brae [900])
[ HoleMumber  |[1 2 [3 4[5 [ &7 &9 [ou|totz]rz14 s [me1z1e] n [T
Yardage 66 150(515 154371337 417 [173(551 |Z084|552] 92 (520276 52351 (445 21 4 541 |=022[6108
Par NEEEEREREREREE R E R R R E EEEN EE D
Handicap ClEE R E N E R |:h12 T2 & |10 & 16|28 14|:[|_ Her
DonMamizan [ 4 [5G4 fa[sls[4a 7 a3 aze[s[s5[4]cl45] 42851z
Frarcis Mattie | 4[4 [7 [3 665 2[5 [42 44557 [s[7 44| 45]8a7 |14
Bob Starie FEEEREER R R R EER R R R R EE
Fraser Ball FENEERE R R R R E R E R = E EE
Martindames |15 (4 [6 [ 74 [6] 54 c 4z ez [e sl a5 |45 4afar [
SteveHenson | 5 |3 |6 [4[6[5[e [« e e |clz 7+ 74|74 5| 479215
Jeff Olfert e EEEERERERE R EEREREEREEEREED T
Dave Ethier HEEEREREERE SRR DR R
MakMacRze |7 |2 |6 (4 [& 65474045 2[cl4[5 45| 2449312
Chiis Knight 1554 elalelae4alala]zzlala]e[4]5]4a|as 14
DaveHewit |6 4 [6 [ 7 [4[[7 |5 =& 0451476745 |5aftoo[i3
Fick Rowsselle || 6 [B [ [4[6[[a| 7z a7 [sa64a 5655 [5][&]|52[106[17
Mote: The lowest 10 scares count. 452 Penalty T—I 454 906
Mormal Skinz Sort By [Date Team Plaverz Golfers
|Fieady... Gross Total | 2008/09/06 | 2 | 12 | 81
3.6.2.1 Exit

To exit the Scores window, click Exit from the menu bar.
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3.6.2.2 Add

The Add menu item offers commands to 2 dropdown menus.

Add
Teams...
Flayers. .,
Round...

To add teams, click Add|Teams... from the menu bar.

Inter-Club Teams ]
Team 1: Arnprior I

Team 4 Teams: | 7

Pl Per Team: | 12
Team B Izland Brae AErs T e =
Team & I
Ready ...

Team Command Buttons — These command buttons
Teams — This text box displays the number of teams.
Players Per Team - This scroll text box allows users to select the maximum number of players per team.
Best scores — This scroll text box allows users to select the number of best scores to count per team.
* Click the Exit button when finished.
To add players to a team:

1. Click the button displaying the team’s name.
2. Click Add|Players... from the menu bar.
3. Select players from the list on the left and click the Add button.

To add player’s round:

1. Click Add|Round... from the menu bar
0
press F5 key from keyboard.

2. Select player from the list and click the Add Round button.

Note: Players will not appear in the list, if their round has been added.

3. Enter player’s hole-by-hole score and click the Enter button (See Section 3.6.1.2 for instructions).

=

3.6.2.3 Edit

The Edit menu item offers commands to 3 dropdown menus.

Edit

Round. ..
Handicap. ..
Handicap Factor...
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To edit player’s round:
1. Click Edit|Round... from the menu bar
or
press F6 key from the keyboard.
2. Select player from list and click the Edit Round button.
Players will not appear in the list, if their round has not been added.
3. Edit hole-by-hole scores of the selected player and click the OK button.
To move the flashing arrow, click the Hole Number display area, above the hole-score that
requires adjustment.
To edit player’'s Handicap:
1. Click Edit{Handicap... from the menu bar.
2. Select player from list and click the Edit Hcp button.
3. Enter new Handicap and click the OK button.
To edit player's Handicap Factor:
1. Click Edit{Handicap Factor... from the menu bar.
2. Select player from list and click the Edit HF button.
3. Enter new Handicap Factor and click the OK button.

3.6.2.4 Delete

The Delete menu item offers commands to 1 dropdown menu.
Delete
Tean, .. |

To delete a team:

1. Click Delete|[Team... from the menu bar.
2. Select team from list and click the Delete button.
3. Click the Yes button on the Confirm... window.

3.6.25 View

The View menu item offers commands to 6 dropdown menus.

| View
W ross Scores
Skins Onky
Handicap Fackors
v 18 Hole Handicaps
v Show Scores
Hide Scores

3.6.2.6 Skins

The Skins menu item offers commands to 2 dropdown menus. If the Skins option has not been
selected, this menu item will be disabled.

Skins
add. ..
Rernove. ..

To add players playing skins:
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1. Click Skins|Add from the menu bar.

2. Click players from the list on the left and click OK button.

To remove players playing skins:
1. Click Skins|Remove from the menu bar.

2. Click players from the list on the left and click OK button.

3.6.2.7 Print

The Print menu item offers commands to 3 dropdown menus.

Prink

Deep River
Grass Skins Resulks
Cifficial Scorecards. ..

Page 3-17
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3.7 Zip and UnZip
Zip UnZip
ko Archive fFrom Archive. ..
ko LISE Drive. .. fFrom USE Drive. ..

3.7.1 Zip Files

To zip files to c:\golfsoft\archive\stroke18.zip
e Click Zip from the main menu and click to Archive .
To zip files to USB Drive:

* Insert USB Drive into USB port.
» Click Zip from the main menu and click to USB Drive .

3.7.2 Unzip Files

To extract files from c:\golfsoft\archive\stroke18.zip to c:\golfsoft\stroke18
» Click Unzip from the main menu and click from Archive .
To extract files from USB Drive to c:\golfsoft\stroke18

e Insert USB Drive into USB port.
* Click Unzip from the main menu and click from USB Drive .

3.8 Help

The Help menu item offers commands to 3 dropdown menus:
Help
G0 ko Galfsaft Saftware \Website

online Manual
about, ..

Page 3-18

To go to the Golfsoft Software website, click Help|Go to Golfsoft Software Website  from the menu bar.
To go online and view the 18-Hole Stroke Play User’s Manual, click Help|Online Manual from the menu

bar.

To learn more about 18-Hole Stroke Play application, click Help|About... from the menu bar.
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4. COMMAND BUTTONS

You choose a command button to initiate an action, such as carrying out or cancelling a command.
Common command buttons are OK and Cancel. They are often located along the bottom or on the right
side of the dialog.

A command button, followed by an ellipsis (...) or a double greater-than sign (>>) opens another dialog
box.

Unavailable command buttons are dimmed. The currently selected button has a darker border than other
buttons. You can choose the currently selected button, simply by pressing the Enter key.

To choose a command button, click the command button. Or press the Tab key until the button you want
is selected, and then press the Enter key.

After you start a new event or open an old event, the screen will display several command buttons:

Event Signup Sheet Courses Flightz Stableford Tee Times

Simply, click the appropriate command button.

4.1 Event

This command button opens the Old Event dialog, which allows users to edit changes to parameters that
were set during create new event procedure (See Section Error! Reference source not found. ).

oidEvent X
Mame af Event: Mens Might I 1

MHame of Club: |Deep River Golf Club [1972] Inc.
Date: | Monday. May 5. 2008 2E

X Skins

" S5kinz Format

Handicap:l Grozs & Met j| [X Stableford Handicap:l et j|

Allowance: | 100% = . = -

T_','FIE af Stroke P'a_lrl_ Allowance: | 100% J
Round Type: ® Individual

Courge Ratings: 3594123 | Sl Entry Fee: I $0.00

" Entry Fee for Event

bember: $5.00 M aon-tember:| $5.00

F'a_l,l:| Pro Shop

Total Caollected:| $230.00 | OK | Cancel

Ready ...
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4.2 Signup Sheet

This command button opens the Signup Sheet dialog, which allows users to determine who can play in
the competition.

Signup Sheet |

[¥X:Members Dnly! |' Gender

c @ L ] C L O o | &

Iéat.:.sdults | rw m w w

[® 5eniors

[ Juniors | 1] 4 | Cancel
Ready ..

Members Only — This check box determines if non-members can play in the competition.
Status — Select one or multiple options.
Gender — Select one of three options.

e Click the OK button, to accept changes.
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4.3 Courses

This command button opens the Courses dialog, which allows users to modify the current course
information, such as: yardage, par or handicap. This dialog also allows users to select the tees of the
home course or select an away course and the tees.

x4

‘Modify Course! Home Courze I
| Deep River Golf Club | 70123 | Away Course |

HoleMumber || 1 || 2 || 3 |[ 4 |[ 5 ([ & [ 7 (& [ 9 || Out Jj 10 (11 [12 [[13 (14 [[15 (16 (17 (18 | In |/ Taot
Tardage (536 |[293 (433 (155 (1371 (1389 || 216 | 362|525 || 3280 (1491 (354 (361|185 310|423 |147 | 421 | 475 || 3167 [|6447
Par |5 4[4 3[4 (a3 |4 (8365|443 (443 (|45]| 36| 7
Handicap 1 (135 (179 || 7 ji15 (11 | 3 2 (&8 (1216 |14 (1018 |[ 4 |[ B

(1] Cancel
|F|eau:|_l,l...

Home Course - Click this command button to select the tees of the home course.
Away Course - Click this command button to select an away course and the tees.

Modify Course - Click this command button to modify the details of the selected course, such as:
yardage, par, and Handicap stroke holes.

43.1 Modify Course

This command button opens the Modify Course dialog, which allows the user to modify the course
information such as: yardage, par, and Handicap stroke holes.

Modify Course <]
Front Nine -
HoleMumber [ 1 |2 |3 [ 4 [ &5 |6 |7 | & | 9 |[Tatal “
Yardage ||536(293 433 [ 155|371 389 | 216 362 || 525 ||3280 | Cancel I
Par El4 4l 4afalsla]5]| 3
Handicap T3 als|4falelz:

Back Nine
Hole Murmber [ 10 11 |12 {13 (14 (15 |16 |17 || 18 |[Tatal
Yardage [|491)/354|[367[185)|310)| 423|147 421(| 475 |[3167
Par S a4 3 al4aqg3|)a)s| b
Handicap T4 e al7laalzi|:3

Par for hale number 17

e Click the OK button, to accept changes.
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4.3.2 Home Course

This command button opens the Home Courses Selection dialog, which allows the user to select the
tees of the home course.

Home Course Selection... ﬂ

¥ Courses

Rating/Slope

18-Hale Front Back E 3 . ey
[69.9]121] [35.0/121] [34.9/121] IDH: | 1 LEEEEEREINES i Y """'
Marme of Course: e il Governor:
| Deep River Golf Club RCGA
Hales™ | Province:
’V Ca @3 | Ontario
Hole Mumber || 1 | 2 (3 (4 |5 (6 || 7 (8 || 9 | Out |10 (31 12 )13 |[14 |15 [[16 |[17 (18 | In | Tot
Yardage [ 536||293 (433 (155|371 383 |[216||362 |[525 |[3280 491 (354 |[361 |185 (1310|423 (147 | 421 || 475 || 3167 ||E447
Par 5 (4 43[4 |43 2636 [5[4 (43443 [a|b] 3]
Handicap T 013 (& 179 ([ 7 15 (11| 3 2 |8 (12|16 | 14 |[10 |18 | 4 | B
Yadage 491|231 (361 (1071|312 (314 |[147 | 287 |[456 |[2700 435 (293 |28 || 155 (240|389 (113 | 362 || 406 || 2630 || 53590
Par 15 (3434|432 |63 [5(4 (4|34 [a]3[4a4|]4]35]-70

Handicap [ 1 |15 2 973 |[5 (1217 (I 2 [ 2 10161412012z [ & [N

2 Red/Blue Esc KE?

to Cancel

Ready ...

To select the tees, click the appropriate button displaying the color of the tees or type the number that is
displayed on the button. For example: press the 2 key from the keyboard, if you want to set the tees to

Red/Blue.
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4.3.3 Away Course

This command button opens the Away Courses Selection dialog, which allows the user to select away
courses and tees.

Away Course Selection... ﬂ
* Lizt of Courzes: | Bear Mountain Golf & Country Club - |

Courses

Rating/Slope
18-Hale Front Back

| | | | |
72.9 147 §136.8/148 1 36.1 /142 PRI FX)
RREE:] EXGEN EEGES l“ame of Course:

Bear Mountain Golf & Country Club
[68.4[129] [34.27129] [34. 21129]

Prodince oc RCGA

T Holes ]
@18 g Governor:

Hole Number [ 1 ]| 2 | 3 [ 4 | 5 | 6 ] 7 | 88 [ Out [ 1011 [12 131415 [ 16 17 |18 ] In | Tat
Vadage |54 |75 395 | 194 493 432|173 483 556 2650 | 364 | 152 423 488 523 471 |189 | 343 |603| 3662 7212
Pa_ |54 434|353 |&|a|a|4]6]a|3[a|5]|am]|r
Handicap |17 |15 13| 8 |1 |3 |11 5 |7 12 14 |8 | 2 |10 6 |16 18 &
Vadage |523 348 362|183 454 410|165 443 537 2421 | 338135 407 463 508 432 |77 | 311 661 | 2322 [E7ad
Pa_ |54 434|353 |&|a|a|4]6]a|3[a|5]|am]|r
Handicap |17 |15 13 8 |1 | 3 115 | 7 I: 12148 | 2 |10 6 |16 18 4 I:
Vadage |508 325 329 150 423|237 | 148 431 |521 2232 | 315|128 369 437 480 390 166 | 299 |510| 7104 5336
Pa_ |54 434|353 |&|a|a|4]6]a|3[a|5]|am]|r
Handicap |17 |15 13| 8 | 1 |3 |11 5 | 7 [WEM| 12|14 8 |2 |10 6 |16 18] I:

Yardage  |420|(325 323 88 389283 |148 413 /440 |2835 || 315 (116 (/359 | 345 (/464 393 1155|369 (433 || 3045 |5553
Par G |4 1434 (4245361434454 3|[4]5]|36]72
Handicap [[17 (115 (13 ]38 || 1 || 3 (11| 5 [ 7 12 74 08 |2 10|/ 6 JI16 18 | 4
Yardage  |533|/415)/384 [|3761414 1316|155 384 183 || 3165|215 | 90 [[315]/345 (/387|273 [ 95 (259 (44912434 |15533
4 5
3 7

Pax  |[5[4a ]34 3| 4 ® [aaafalsfalzalls]|z:]|z
Handicap |17 [15 13 ] 3 [ 1 1[5 |- 12148 |2 [0 & (1818

+ -
1 Gold | 2 Blue 3 Black 4 White 5 Red \:Esc]{ey
Search h_-,uII to Cancel

| Type the |0 number of the away courze, then press the Enter key...

List of Courses — This combo box allows the user to select an away course from the COURSES
database. If the ID number of the course is known, the away course may be select with the Search by
button. Click the Search by button and enter the ID number in the appearing text box.

To select the tees, click the appropriate button displaying the color of the tees or type the number that is
displayed on the button.
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4.4 Flights

This command button opens the Select Flights window and allows the user to set flights of the
competition. Up to 15 flights may be selected. The dialog also displays the number of players in each
flight and the players in the competition. Initial start up of this dialog, during a new event setup, the
number of flights is usually zero and the flight boxes are not visible.

Set Flights for 9-Hole Stroke Play ]

&Fiight | BFight | CFlight | DFlight | E Flight oK

(v (4] |27 [4] |28 (2] [29[4] |30 3] E;n::el

| 26 |27 |28 |29 | 30
o [0 |0 |0 |oO Fights

FFlight | GFlight | HFlight | IFlight | J Flight 15 il
|31E| |32|§| |33E| |34E| |35E| Plagers

| 31 | 32 |33 |34 |35 0
| u | D | u | u | u | Copy From

K. Flight L Flight I Flight M Flight O Flight Flight By

|35E| |3?|§| |33E| |39E| |4uE| ® Handicap

I 36 I 37 I 1m I 19 I a0 ) Handicap Factar

‘o [o [0 [o |o
[ tanual Magimum Handicap IE@

¥ Use 18-Hole Factor

iSet Min / Max!

Ready ...

Flights — This scroll control allows the user to set the number of flights. As you increase or decrease the
number of flights, flight details are made visible or not visible, respectively.

Set Min / Max — Click this command button to fill in all the fields displaying the flight ranges. The first
flight will display the minimum Handicap and last flight will contain the maximum Handicap.

Flight Spin Controls — Click the up arrow of the appropriate spin control and hold down the mouse
button, then release the mouse button when the desired Handicap range is displayed. Likewise, repeat
the latter by clicking the down arrow of the appropriate spin control to decrement the desired Handicap
range.

Manual Maximum Handicap - Select this check box to use a manual maximum Handicap. After
selecting this option, select the manual maximum Handicap with the spin control and click the

Set Min / Max button.

Use 18-Hole Factor — Select this check box to use 18-hole Handicap Factor of players to calculate their
9-hole Handicap.

e Click the OK button, to accept changes.
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45 Stableford

This command button opens the Stableford Points window and allows the user to change or set up the
Stableford points for: hole-in-one, double eagle, eagle, birdie, par, bogey, double bogey, and triple bogey.
The dialog also allows the user to set the format and percent handicap allowance.

Net
Double Eagle:

T
El
=
=l
[

x|
akK
Cancel
Farrnat

I Met j|

Eagle:
Birdie:

Far:

Allowance

Eogey:
Double Bogey:
Triple Bogey:

SEERERE

0 2 0 2 K 2 3 K 3 K K

Hole-ln-0ne:

Feady ..

To set the points, click the appropriate Up and Down scroll arrows.
Format — This combo box allows the user to select one of three format options: Gross, Net or Quota.

Allowance — This combo box allows the user to select one of four percentages options: 100%, 95%, 90%
or 80%. This option is used by the application to calculate Handicaps and Handicap Factors. This option
is not available, if Gross or Quota format option has been selected.

If Quota option is selected, players start with half their 18-hole Handicap. For example, a player with an
18-hole Handicap of 17 would start with 8.5 points.

e Click the OK button, to accept changes.
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4.6 Tee Times

This command button opens the Tee Times dialog, which allows the user to:

e Setup the draw.
¢ Signup players.
e Check in players (paid).
¢ Add players that have been signup with another method.
« Edit Handicap Factors.
¢ Replace or switch players.
¢ Replace or switch starting tees.
« Delete players from the tee sheet only or from the competition.
¢ Print signup sheets and tee times.
No Morning Draw Setup for 9-Hole Stroke Play

In, Addl Edit Replace: Deleter Frint  Done

4.6.1 Exit

To exit the Tee Times dialog, click Exit from the menu bar.
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4.6.2 Setup Draw...
To open the Tee Times Setup dialog, click Setup Draw... from the menu bar.
_ioix]
Type of Course
Date:| Saturday. August 30_ 2008 { @ 13Hde O 9Hole
r Morning Draw rAfternoon Draw
Hour  Minute Hour  Minute
Start Time: Iﬁlg Iﬁlg 200 am Start Time: ’ﬁ@ WE 1:00 pm
Interval: Iﬁlg Minutes [ Shotgun Interval ’ﬁ@ Minutes [ {Shatgun
Plapers:| 72 E Players:| 52 E
Groups:| 18 10th Tee Startt:;| 9 Ig Groups:| 13
18 Forezomes 0 Threesomes 13 Forezomes 0 Threesomes
Group Size—— I Starting Groups Per Tee [13] Group Size——
O Twa Holett1:[1 [&] Haletiz[1 [ | © Twe
O/ Holett2 (1 [3] Holetrrr:[1 [3] | | © Theee
® Four ® Four
O Five Holett3: (1 [¢] Hele1Z[1 [8] | | e
G Holeﬁ4:|1_g Hole#1 3:'1_3 @
HolettS: (1 [4]  Holett14:[0 (4]
Holette:[1 (4] Holett15:[0 [4]
Holett?:[1 [2] Holettie:]0 [2]
Holettz:[1 [2] Holett7:0 [4]
Holett®[1 [2] Heletiz:[0 [4]
| Save || Import I
0K Esc Key
= to Cancel
| Ready ...

After selecting options and setting parameters, click the OK button to accept.
Date — This box displays the date of the competition.

Type of Course — These options select the type of course and how many holes are displayed in the
Starting Groups Per Tee frame.

Morning and Afternoon Draw

Start Time — This display area is used to set the starting tee time or first tee time. The Hour spin
control is for setting the hour and the Minute spin control is for setting the minutes.

Interval — This display area is used to set the time interval (in minutes) between tee times. If the
Shotgun check box is selected, the spin control is disabled.

Shotgun — This check box selects the event to a shotgun start, otherwise tee times.

Players — This text box sets the maximum number of players that can play in the event. Use the
spin control to the right to increase or decrease this number.

Groups — This box displays the number of groups.
Group Size — These options select the group size.

Starting Groups Per Tee - These spin controls allow you to set the number of groups that start
on each hole during a shotgun start. If the Shotgun check box is not selected, this frame will not
be visible.
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4.6.3 View

The View menu item offers commands to 3 dropdown menus.

Wigst
v Flayers

Teanms
Handicap Fackors

Click the appropriate dropdown menu item to view Players, Teams or Handicap Factors.

4.6.4 Sign Up

To set the Current Mode in Sign Up mode, click Sign Up from the menu bar. The Sign Up mode allows
users to sign up players to tee times and scorecard. While in Sign Up mode, available tee times are
displayed in yellow background.

515 pm | >:>>>|

To enter a player’'s Handicap Factor manually, select the Ask for Handicap Factor check box; otherwise
the application will extract the current Handicap Factor of the player from the member’s database.
Handicap Factors for Non-Members must be entered manually.

To sign up multiple players using the display above:

1. Click the >>>> box.

2. Select each player from the list and click the OK button.

3. Ifthe Ask for Handicap Factor check box is selected, enter the player's Handicap Factor and
click the OK button.

To sign up a single player:
1. Click one of the yellow boxes.
2. Select player from the list and click the OK button.
3. Ifthe Ask for Handicap Factor check box is selected, enter the player's Handicap Factor and
click the OK button.

To turn off Sign Up mode, click Done from the menu bar.

4.6.5 Check In

To set the Current Mode in Check In... mode, click Check In from the menu bar. The Check In mode
allows users to select or unselect players that paid their entry fee to the competition. Paid players are
displayed in yellow background and unpaid players are displayed in white background.

515 pm | A, | Doug Bonnett Kevin McCrimmon Malcolm James lan Joynes

Click the appropriate box to select or unselect paid players.
When the player is checked in and not on the scorecard, that player will be added to the scorecard.
To turn off Check In mode, click Done from the menu bar.
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4.6.6 Add

To set the Current Mode in Add mode, click Add from the menu bar. The Add mode allows users to sign
up players to tee times. While in Add mode, available tee times are displayed in yellow background.

Add mode is similar to Signup mode, except:

» The selection list is limited to players that were signup using the Signup... menu item.

» Players are not added to the scorecard.
To add players to scorecard you must use the Check In option, described in Section 4.6.5 or add
the player via the Scores dialog, described in Section 3.6.1.2.

To turn off Add mode, click Done from the menu bar.

4.6.7 Edit

To set the Current Mode in Edit mode, click Edit from the menu bar. The Edit mode allows users to:

» Perform random draw of starting holes for shotgun start tee times.
e Clear tee times display.

» Edit starting holes and tee times.

* Load players from signup sheet.

* Import players from Tee Time application.

» Update and adjust Handicap Factors.

Draw Tees I| Clear... Il Load... I| Import. .. I| Update Handicap Fa-::tursl

To perform a random draw of starting holes for shotgun start tee times, click the Draw Tees button once
or several times.

To clear the tee times display, click the Clear button.
To edit starting hole, click the tee name that you want to change in the Tee column and enter the new
starting hole or tee name.
To edit tee time:
1. Click the tee time that you want to change in the Time column.

Howr  Minute (" Moming

IFEI lﬁ@ ) Afternoon

5:20 pm (& Evening

Cancel |

The Hour spin control is for setting the hour and the Minute spin control is for setting the minutes.

2. Adjust the Hour and Minute spin control.
3. Select Morning, Afternoon or Evening option.
4. Click the OK button.

To update Handicap Factors and recalculate Handicaps:

1. Click the Update Handicap Factors button.

2. To update Handicap Factors and recalculate Handicaps automatically from the member’s
database, click the Yes button; otherwise click the No button.
The dialog is now in Update Handicap Factors mode.

3. To edit a player’s Handicap Factor, click the box containing the player's name and enter their
Handicap Factor, and then click the OK button or press Enter from the keyboard. The application
will recalculate the player’'s Handicap.
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To set or edit starting tees:

1. Click the box in the Tee column and enter the starting tee and click the OK button or press Enter
from the keyboard.
2. When you are finished setting or editing starting tees, click Done from the menu bar.
To set or edit tee times:
1. Click the box in the Time column and set the tee time and click the OK button or press Enter
from the keyboard.
2. When you are finished setting or editing starting tees, click Done from the menu bar.
To turn off Add mode, click Done from the menu bar.

4.6.8 Replace

To set the Current Mode in Replace mode, click Replace from the menu bar. The Replace mode allows
users to:

* Replace one player with another.
* Replace starting hole.
« Delete player from tee time display only.

To replace players, click one player’'s name then click the other player’'s name.
To replace starting holes, click one tee name then click the other tee name.

To delete a player from the tee time display only, click the player's name then click the waste basket and
click the Yes button from the Confirmation window.

L e,
i
|
|

"y T
il

|.
LRl

To turn off Replace mode, click Done from the menu bar.

46.9 Delete

To set the Current Mode in Delete mode, click Delete from the menu bar. The Delete mode allows users
to delete players and tee times from the tee time display.

To delete a player, click the player's name and click the Yes button on the Confirm... window.

To delete a tee, click the tee name in the Tee column and click the Yes button from the Confirmation
window.

4.6.10 Print

The Print menu item offers commands to 2 dropdown menus.

Prink

Signup Sheet
Tee Times...

To print signup sheets, click Print|Signup Sheet from the menu bar.
To print tee times:

1. Click Print|Tee Times from the menu bar.
2. Select one of two options and click the OK button.
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4.6.11 Done

To set the Current Mode to No Mode, click Done from the menu bar.
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5. DISCLAIMER
5.1 IT IS ILLEGAL TO MAKE UNAUTHORIZED COPIES OF TH IS
SOFTWARE

This software is protected under federal copyright
copies of this software except to make a backup cop
this software for any other reason including for sa
Penalties include fines as high as $50,000 and jail

law. It is illegal to make or distribute
y for archive purposes only. Duplication of
le, loan, rental or gift is a federal crime.
terms up to five years.

5.2 Golfsoft Software Product Warranty

The enclosed software product and the user manuals
all rights. No part of this user manual or any kin
reproduced or translated in any form or medium with
Software.

Golfsoft Software warrants to the original consumer

in this product will be free from defects in materi
receipt). If any diskettes or CDs supplied as part
provided that the consumer purchaser returns the me
the instructions in the following paragraph, Golfso
diskettes or CDs free of charge. This warranty is
this product (dated purchase receipt should be reta

To obtain a replacement diskette or CD, please retu
Golfsoft Software at the address below, accompanied
purchase receipt, your name and return address.

53 Disclaimer Notice

The software, diskettes, CDs and documentation are
merchantability, no warranty of fithess for a parti
either expressed or implied regarding the software,
expressly provided in the preceding paragraph. Acc
to the use, results and performance of the software
event will Golfsoft Software be liable to any perso
special or indirect damages resulting from possessi
including without limitation, damage to property an
personal injury, even if Golfsoft Software has been
damages or loss.

Under this warranty the user agrees that the liabil
kind of legal claim (whether in contract, tort or o
suggested retail price for the use of this product.

The terms “RCGA”, “RCGA Handicap Factor”, “Handicap

(N)”, “RCGA Handicap System”, “SLOPE”", “Slope Syste

“RCGA Course Rating”, “RCGA Slope Rating”, “Course

trademarks and service marks. With the exception o
and service marks are the property of the United St
Royal Canadian Golf Association and the Canadian La

system. As owner of the term “RCGA” and a Licensee

service marks, the RCGA has the sole right within i
marks by others.

This software was certified by the RCGA and can onl
associations that issues and maintains RCGA Handica
Handicap System as described in the RCGA Handicap S

are copyrighted and Golfsoft Software reserves
d of the accompanying materials may be copied,
out the prior written consent of Golfsoft

purchaser that the diskettes or CDs furnished
als and workmanship (as evidence by your
of this product prove to be defective and
dia to Golfsoft Software in accordance with
ft Software will replace and defective
valid for 30 days following the purchase of
ined as proof of purchase).
rn the diskette or CD only, postage prepaid to
by a statement of the defect, a copy of your

provided “as is”. There is not warranty of
cular use and no other warranty of any kind,
diskettes, CDs or documentation, except as
ordingly, the user assumes the entire risk as
, diskettes, CDs and documentation. In no
n or organization for any consequential,
on, use or malfunction of this product,
d to the extent permitted by law, damages for
advised of the possibility of any such

ity of Golfsoft Software arising out of any
therwise) will not exceed the manufacturers

Factor”, “Factor”, “RCGA Handicap Factor
m”, “Slope Rating”, “Handicap Differential”,

Handicap” and “Home Course Handicap” are

f the term “RCGA”, some of these trademarks
ates Golf Association, which has given the
dies Golf Association permission to use the
of those well-established trademarks and
ts jurisdiction to authorize the use of those

y be used by golf clubs or authorized golf
p Factors in full accordance with the RCGA
ystem manual. Golfsoft Software will not in

any way be held accountable for the misuse of this

All elements of this software and user manuals are copyright 1999-2011, Golfsoft Software. All rights

software.

reserved. Box 841, 25 Huron Street, Deep River, Ontario KOJ 1PO.

Telephone: (613) 584-4652 or Cell: (613) 639-9408.
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PRINT SAMPLES

The print samples are not actual size.

6.1

Skins

Les Fraser Memorial Trophy

Skins Results

Page 6-1

Saturday, September 6, 2008

Skins Value: $111.43

Gross
Handicap Range: +4 to 39
Player Score Hole Par
Gord Kelly Birdie 1 4
Jason Leroux Birdie 2 3
Carry Over 3 5
Carry Over 4 3
Carry Over 5 4
Carry Over 6 4
Steve O'Donnell Birdie 7 4
Carry Over 8 3
Reiley O'Brien Birdie 9 5
Carry Over 10 4
Carry Over 11 3
Kerry Powell Birdie 12 5
Carry Over 13 4
Jeff Brennan Birdie 14 5
Carry Over 15 3
Fraser Ball Birdie 16 4
Carry Over 17 3
Carry Over 18 4
Players: 78
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Signup Sheet (Option 1)
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Signup Sheet (Option 2)
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Tee Times (Option 1)

Tee Times

Saturday, September 6, 2008

Les Fraser Memorial Trophy

Morning Draw

Tee Time Player 1 Player 2 Player 3 Player 4

1 | 10:40 am Doug Reynolds Mike Coucke Rob Carroll

1 [ 10:48 am Justin Miller Lome Keon Dave Ethier Gerry Pulcine

1 | 10:55 am Gary Hobin George Berube Conrad Stresman Ken Moulton

1 | 11:04 am Dave Jones Rick Rousselle Bill Devescar Dave Lawrie

1 [ 11:12 am Darwin Margquardt Helmut Plattner Bruce Hanna Al Corrin

1 | 11:20 am Steve Henson Brad McCilguham Don Green John David

1 | 11:28 am Jason Leroux Ran Vanalstine Raon Price Francis Mattie

1 | 11:36 am Bill Scheel Richard Pragnal Terry Smith Ken Roman

1 [11:44 am Dan Patrick Bryan Kealey Jeff Olfert Rob Johnson

1 | 11:52 am Gord Kelly Paul Seguin Reiley O'Brien Steve Posthumus

1 | 12:00 pm Gilles Chartrand Dave Hewitt Garry Weston Mark Attley

1 [ 12:08 pm Harvey Murray Mike Boudens Gord Radford Ralph King

1 | 12:16 pm Chris Knight Kert Ellison Kerry Powell Lawerence Gallagher

1 [12:24 pm Wayne Bresseau Steve O'Donnell Winston Sunstrum Bob Storie

1 | 1232 pm Jeff Brennan Tony Belcourt Ron Carr Doug Hawkins

1 [ 12:40 pm Stephen Keegan Steve Lacombe Mark MacRae Brock Sine

1 [ 12:48 pm Larry Skinner Kevin Bossy Russ Holmberg

1 | 12:55 pm Brian Gardner Fraser Ball John Kiser Blake Sutherland

1 1:04 pm Dustin Zohr Brent Clifford Wally Mick

1 1:12 pm Don Marrison Chris Jarvis Andrew Rowat

1 1:20 pm Dan Paope Daryl Craig Kaz Rudzinski Martin James
Golfsoft Software Page 1
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Tee Times (Option 2)

Tee Times

Players

Doug Reynolds
Mike Coucke
Rob Carroll

Gary Hobin
George Berube
Conrad Stresman
Ken Moulton

Darwin Marquardt
Helmut Plattner
Bruce Hanna

Al Corrin

Jason Leroux
Ron Vanalstine
Ron Price
Francis Mattie

Dan Patrick
Bryan Kealey
Jeff Olfert
Rob Johnson

Gilles Chartrand
Dave Hewitt
Garry Weston
Mark Attley

Chris Knight

Kert Ellison

Kerry Powell
Lawerence Gallagher

Morning Draw

Tee

1

10:40 am

1

10:56 am

1

11:12 am

1

11:28 am

1

11:44 am

12:00 pm

12:16 pm
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Saturday, September 6, 2008
Les Fraser Memorial Trophy

Players

Justin Miller
Lorne Keon
Dave Ethier
Gerry Pulcine

Dave Jones
Rick Rousselle
Bill Devescari
Dave Lawrie

Steve Henson
Brad McCilguham
Don Green

John David

Bill Scheel
Richard Pragnal
Terry Smith

Ken Roman

Gord Kelly

Paul Seguin
Reiley O'Brien
Steve Posthumus

Harvey Murray
Mike Boudens
Gord Radford

Ralph King

Wayne Bresseau
Steve O'Donnell
Winston Sunstrum
Bob Storie

Tee

10:48 am

1

11:04 am

1

11:20 am

1

11:36 am

1

11:52 am

12:08 pm

12:24 pm
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6.6 Net Scores

Les Fraser Memorial Trophy September 6, 2008
A Flight (+4 to 12)
Scores Net / Gross

Yardage 366 160 515 184 271 337 417 173 561 3084 355 93 520 2765 523 151 446 214 241 2022 6108
Par 4 3 5 3 4 4 4 3 5 3B 4 3 5 4 5 3 4 3 4 35 70
Handicap 9 17 7 13 1 11 3 15 5 Blue 12 18 4 10 6 168 2 & 14 Blue

Player 123 4567 8 9 Out101112131415161718 In Tot Hcp HF
1 Reiley O'Brien 344435333 32 33434452305 34 66 12 109
38 40 78 :
2 Mark Aftley 43333454433 444463434 36 69 4 45
39 41 80 '
3 Andrew Rowat 335343325 3 6445643444 71 4 54
37 45 82 '
4 John Kiser 333442455 33 3484534343 711 45 419
39 44 83 ’
5 Larry Skinner 43444443434 33467343538 72 5 449
40 44 B4 '
6 Don Morrison 354434446 37 33544453253 73 5 419
43 42 85 '
7 Daryl Craig 345344435 3562536363353 74 .4 01
41 44 85 ’
8 Dan Pope 445444544 38 42636434436 74 ., 455
44 41 85 '
9 Tony Belcourt 445344454237 335444464237 74 5 15
43 43 86 ’
10 Mike Boudens 54443633537 53634254638 75 14 08
43 43 86 :
11 Helmut Plattner 6 3444445539 43445443536 75 5 09
45 42 &7 '
12 Blake Sutherland 4 3 4 4 3 4 6 4 4 36 3 47 65532439 75 .5 410
42 45 87 ’
13 Kerry Powell 54434743539 533553553337 76 44 4014
45 42 a7 :
14 Gary Hobin 34433344533 4463635447 43 76 5 444
39 49 88 :
15 Gard Kelly 2443645805 4 434454432536 77 4 00
47 41 88 :
16 Harvey Murray 33743 3455 3y 536364535 40 77 .
43 a5 89 12 111

17 Jason Leroux 6 2 6 3 45 345 38 44455 44406 40 78
44 45 sy 11107

18 Mike Coucke 5343 434355 36 7 4457443 4 42 78
11 102

42 47 89

19 Doug Hawkins 334453445 35 4358465835 43 78
41 49 90 12 116
20 Fraser Ball 445355645 4 445056323537 78 415 (41
a7 43 90 .
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6.7 Gross Scores

Les Fraser Memorial Trophy September 6, 2008
A Flight (+4 to 12)
Scores Gross / Net

Yardage 366 160 515 184 371 337 417 173 561 3084 358 S92 520 376 523 131 446 214 341 2022 6108
Par 4 3 5 3 4 4 4 3 5 3B 4 2 5 4 5 3 4 3 4 3 70
Handicap 9 17 7 13 1 11 3 15 5 Blue 12 18 4 10 & 16 2 & 14 Blue
Player 123 456 7 8 9 Out101112131415161718 In Tot Hcp HF
1 Reiley O'Brien 4 45 446 4 3 4 38 435454645 40 78 12 109
32 34 66 :
2 Mark Attley 534 3 45645 39 445573544 4 80 1 101
33 36/ 69 '
3 Andrew Rowat 4 36 354426 37 64567 4454 45 82 11 104
31 a0 71 '
4 John Kiser 4 34 45 3556 39 449563544 44 83 12 111
33 38 i )
5 Larry Skinner 535 4555 35 40 43 5 7 835 45 44 84 12 112
34 i’/ 72 '
& Don Morrison 4 55 4455 47 43 4 3 6 5 5 46 4 5 42 85 12 111
37 w73 '
7 Daryl Craig 4 46 355536 4 6264737 4 5 4 85 1 103
35 39 T4 )
8 Dan Pope 546 4556 405 44 4 27 47 445 4 4 85 1 103
38 B/ T4 '
9 Tony Belcourt 546 355585 5 43 4 3 65 5 457 4 43 86 12 115
7 v T4 :
10 Mike Boudens 6 45 447 4 36 43 537 45 2656 43 86 11 108
37 | 75 :
11 Helmut Plattner 7 354555 56 4 5 3556 45 45 42 87 12 109
39 w75 :
12 Blake Sutherland 5 35 4457 45 42 4 4 87 6 5 4 3 4 456 87 12 112
36 39 75 :
13 Kerry Powell 6 45 358536 4 53466 366 3 42 87 1 101
39 T 76 :
14 Gary Hobin 4 45 3 445 46 39 547 4755 57T 49 88 12 114
33 43 76 :
15 Gord Kelly 345 3756 86 47 43 5 56 4545 41 88 1 102
41 w77 :
16 Harvey Murray 4 38 4 4 45 56 43 6 3 7 4 7 4 6 4 5 46 89 12 111
7 40 v :
17 Jason Leroux 7T 27 3 56 4 46 44 4 4 5 6 6 45 5 6 45 89 1 107
38 a0 78 :
18 Mike Coucke 6 35 35 4556 42 7 4 5 6 8 45 4 4 47 89 1 102
36 42 78 '
19 Doug Hawkins 4 35464546 4 536575945 49 90 12 116
35 43 78 )
20 Fraser Ball 546 366 7 406 47 5 4 6 6 7 3 3 4 5 43 90 .
41 a7 78 12 111
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Callaway Scores

Callaway

Yardage
Par
Handicap

Player
John Kiser
Reiley O'Brien
Garry Weston
Mark Aftley
Andrew Rowat
Brent Clifford
Larry Skinner
Blake Sutherland
Rob Johnson
Ken Roman
Bruce Hanna
Brock Sine
Steve O'Donnell
Bill Scheel
Daryl Craig
Dan Pope
Mike Boudens
Gerry Pulcine
Dan Patrick
Lorme Keon
Francis Mattie

Conrad Stresman

Kerry Powell
Gary Hobin
Kevin Bossy
Kert Ellison
Dave Lawrie
Don Morrison
Paul Seguin
Helmut Plattner
Bob Storie
Gord Kelly
Russ Holmberg
Dave Jones

Les Fraser Memorial Trophy
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September 6, 2008
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In
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40
A |
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45
43
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48
46
A |
43
43
44
a1
43
44
42
42
45
43
42
49
45
43
44
42
43
42
43
a4
43
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6106

70

Tot Hecp Cal
83 14 &9
78 8 70
86 16 70
80 9 71
82 11 7
83 12 11
84 13 71
87 16 11
90 19 71
93 22 T
96 25 71
80 8 72
82 10 72
84 12 72
85 13 72
85 13 72
86 14 72
86 14 72
86 14 72
87 15 72
87 15 72
87 15 712
87 15 712
88 16 72
89 17 72
93 21 72
94 22 72
85 12 73
85 12 73
87 14 73
88 15 73
88 15 73
88 15 73
88 15 73
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Gross and Net Winners

Les Fraser Memorial Trophy
Gross & Net Event

Low Gross #1: Reiley O'Brien (78)
Low Gross #2: Andrew Rowat (82)
Low Gross #3: Larry Skinner (84)
Low Gross #4: Daryl Craig (85)
Low Gross #5: Tony Belcourt (86)
Low Gross #6: Mike Boudens (86)
Low Gross #7: Helmut Plattner (87)

Yardage
Par
Handicap

F-S

3
17

(3]

[ %]

Player
Reiley O'Brien
Mark Attley
Andrew Rowat
John Kiser
Larry Skinner
Don Morrison
Daryl Craig
Dan Pope
Tony Belcourt
Mike Boudens
Helmut Plattner
Blake Sutherland
Kerry Powell
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Low Net #1
Low Net #2
Low Net #3
Low Net #4
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Saturday, September 6, 2008

. Mark Attley (69)

: John Kiser (71)

: Don Morrison (73)
: Dan Pope (74)

523 151 446 214

5 3 4 3
6 16 2 8
14 15 16 17
5 4 6 4
7 3 5 4
7 4 4 5
6 3 5 4
8 3 &5 4
5 4 6 4
7 3 7 4
7 4 4 5
5 4 5 7
5 2 6 5
6 4 5 4
6 5 4 3
6 3 6 6
7 5 5 5
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6106
70

Tot
78
80
82
83
84
85
85
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86
86
87
87
87
88

Hcp Net

12
11
1"
12
12
12
11
11
12
11
12
12
1"
12

66
69
m
7
72
73
74
74
74
75
75
75
76
76
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6.10 Net and Gross Winners
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Net Stableford Scores

6.11

September 6, 2008

Les Fraser Memorial Trophy

A Elight (+4 to 12)

Stableford Points (Net)

366 160 515 184 371 337 417 173 561 3084 358 93 520 376 523 151 446 214 341 3022 6106

Yardage

5 4 5 3 4 3 4 3 70
10 6 8 14
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35
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3

15
123 4567 89 Out101112131415161718

4
3
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7 7 13 1 N"

4
9
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Handicap
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6.12 Gross Stableford Scores

Les Fraser Memorial Trophy September 6, 2008
A Flight (+4 to 12)
Stableford Points (Gross)

Yardage 366 160 515 184 371 337 417 173 661 3084 358 93 520 376 523 151 446 214 341 3022 6106
Par 4 3 5 3 4 4 4 3 5 35 4 3 5 4 5 3 4 3 4 35 70
Handicap 9 17 7 13 1 11 3 15 5 Blue 12 18 4 10 6 16 2 4§ 14 Blue
Player 12 3 4567 8 9 Out101112131415161718 In Tot Hcp HF
1 Reiley O'Brien 4 4 5 4 46434 38 435454645 40 78 5 49
21212022315 2 2 2 2 2 10 1 1 13 28 :
2 Mark Attley 5343456 45 30 44557 35 44 41 80 L. 4,
123221012 14 21 2102 11 2 12 26 :
3 John Kiser 4 34453556 30 4409563544 4 8 ., ..,
22311310114 210112112 11 25 :
4 Larry Skinner 535455535 40 435783545 4 8, .,
122111122 13 2 2 2 0 0 2 1 1 1 11 24 :
5 Andrew Rowat 436 354426 37 64567 4454 45 8 . .4y
2 21212231 16 01 2 0 0 1 2 0 2 8 24 :
6 Tony Belcourt 546355555 43 436 5 5457 4 43 8 5 g
1112 11102 10 2 2 1 1 2 1 1 0 2 12 22 :
7 Blake Sutherland 535 4 45 7 45 4 4487 6 5 4 3 4 45 87 5 44,
122121012 12 2 1 00 1 0 2 2 2 10 22 .
8 Daryl Craig 446355536 41 626 47 37 45 44 8 ., 494
21121112112 03 1202011 10 22 :
9 Gord Kelly 34537 5686 47 435564545 41 8 . .5,
31220100110 2 2 2 1 11 1 1 1 12 22 :
10 Kerry Powell 6 4 53 58 5 3 6 4 5 3 4 6 6 3 6 6 3 42 87 11 101
01221012110 1 2 3 01 2 0 0 3 12 22 :
11 Don Morrison 455 445547 43 436554645 42 8 L, .,
20212111010 2 2 11 2101 1 11 M :
12 Mike Boudens 6 45447 436 43 537 452656 43 8 L, .54
6121202211120 223000 10 21 :
13 Dan Pope 546 4556 45 44 427 47 4454 41 8 . 5.
Tt 11111012 9 23020120212 21 :
14 Helmut Plattner 735455556 45 535564545 4 8 ., .59
622111101 9 122111111 1 20 :
15 Gary Hobin 4 453 44546 30 547 475557 49 8 5
21222211114 1 10200100 5 19 )
16 Doug Hawkins 4 3546 4546 41 536575045 49 0 5 44a
22210211112 12 110001 1 7 19 :
17 Mike Coucke 6 35354556 4 7 456 845 44 47 8 . 445
02221210111 012001112 8 19 :
18 Harvey Murray 43 8 444556 43 6 3 7 47 46 45 46 89 L, L,
22012210111 0202201011 7 18 :
19 Richard Pragnal 7 4 6 4 465 35 44 4 46 7 8 45 45 47 01 L, .,
01112012210 2 1 1 00 1 1 1 1 8§ 18 :
20 Terry Smith 73836655 7 6 5 44556 47 35 438 03 ., 4,4
020201101 7 212111021 11 18 .
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6.13 Quota Stableford Scores
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6.14 Scorecards

6.14.1 Official Scorecard

OFFICIAL SCORECARD Blue Saturday, September 6, 2008
CONTESTANT:  Francis Mattie (243) 11:28 am Handicap: 14 Handicap Factor: 13.6

Hole 1 213|456 |7 |89 | Out 10 |11 (12 [ 13 | 14 |15 | 16 | 17 | 18 | In | Total
Yards | 366 | 160 | 515 | 184 | 371 | 337 | 417 | 173|561 | 3084 | | 358 | 93 | 520|376 | 523 | 151 | 446 | 214 | 341 | 3022 | 6106
Par 4 | 35|34 |4 |43 ]|5 35 4 |3 | 5|4 |53 |4]3 4 35

70
Score
SCORER'S SIGNATURE CONTESTANT'S SIGNATURE
Golfsoft Software
Hole 1 2 3 4 5 6 7 8 9 Out 10 |11 |12 |13 | 14 | 15| 16 | 17 | 18 In Total
Par 4 3 5 3 4 4 4 3 5 35 4 3 5 4 5 3 4 3 4 35 70
Scorer's
Score
6.14.2 Net Stableford Scorecard
Net Stableford Scorecard Blue Saturday, September 6, 2008
Francis Mattie (243) 11:28 am  Handicap: 14 Handicap Factor: 13.6
Hole 1 2 3 4 5 6 7 8 9 Out 10|11 |12 |13 | 14 |15 | 16 | 17 | 18 In Total
Yards | 366 | 160 | 515|184 | 371|337 | 417 [ 173|561 | 3084 | | 358 | 93 | 520|376 | 523 | 151 | 446 | 214 | 341 | 3022 | 6106
Hcap 9 17 | 7 13 1 11 3 15| 5 12|18 | 4 10| 6 16 2 8 14
Gross
Strokes | 1 0 1 1 1 1 1 0 1 7 1 0 1 1 1 0 1 1 1 14 14

Net

Par 4 3 5 3 4 4 4 3 5 35 4 3 5 4 5 3 4 3 4 35
Points

70

6.14.3 Gross Stableford Scorecard
Gross Stableford Scorecard Blue Saturday, September 6, 2008
Francis Mattie (243) 11:28 am  Handicap: 14 Handicap Factor: 13.6

Hole 1 2 3 4 5 6 7 8 9 | Out 10|11 12|13 | 14 | 15| 16 | 17 | 18

In Total
Yards | 366|160 | 515|184 | 371|337 | 417 | 173 | 561 | 3084 | | 358 | 93 | 520 | 376 | 523 | 151 | 446 | 214 | 341 | 3022 | 6106
Par 4 3 5 3 4 4 4 3 5 35 4 3 5 4 5 3 4 3 4 35 70

Gross

Points




Page 6-15

6.14.4 Quota Stableford Scorecard



